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1. Introduction

1.1 Welcome to Lanboss Preview6

Lanboss Preview is a standalone print preview program designed to view and
print fixed format text reports. Its features include:

Automatic Scaling Scales the text font size to match the page width and
height

Zoom The page can be viewed at virtually any Zoom level, with
'Whole Page' selected the Zoomed image will also
dynamically scale to the size of the main dialog

Printer Selection You may select and configure the printer you wish to print
to from the main dialog

View History Previous documents are saved to an encrypted database for
easy retrieval at a later date

Admin Mode Using the /S command line switch Lanboss Preview will
save all its settings to registry so that you can export and
distribute the settings to other users, who will then use the
new default values

Default Mode Using the /D command line switch Lanboss Preview will load
it's internal default values instead of reading them from the
registry
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2. Installation

Lanboss Preview is expecting a file name as one of its command line parameters;
this can be accomplished in several ways:

· Associate a file type in Explorer with it

· Drag a file on it in Explorer

· Run it from the command prompt with a file name parameter

During the installation the Lanboss Preview setup program will create the desired
file associations up so that double clicking on a file in Explorer, or single clicking
on a link in Internet Explorer will open up Lanboss Preview with the selected text
file. (See Appendix 5.1 for details on the file association setup).

Once you have chosen and implemented your run method, the next step is to
setup the default parameters. The two types of configuration parameters follow

2.1 Manual Edits

These are edits to the registry that Lanboss Preview will read whilst loading, but
cannot save itself with the /S command line parameter.

There is currently only one setting, but this may be added to, it is 

HKEY_LOCAL_MACHINE\SOFTWARE\Lanboss\lbPreview\Settings

MaxLines : DWORD

Set this to the value required for the maximum number of lines allowed on a
page, the default is 200 if not specified.

This setting is required in the circumstances where the file Lanboss Preview is
loading doesn't have and form feeds in it so tries to squeeze the entire file onto
one page by reducing its font size. The minimum font size allowed is 2pt, if the
number of lines dictates a size below this, and then the remaining lines will flow
onto the next page.
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2.2 Saved Defaults

Under normal operation, Lanboss Preview will read its settings from the system
registry under the key:

HKEY_LOCAL_MACHINE\SOFTWARE\Lanboss\lbPreview

If you wish to make changes to these defaults, run Lanboss Preview with either /
S and /D command line switches or just the /S parameter. The /S parameter tells
Lanboss Preview to Save its settings, if you use the /D parameter as well it will
stop Lanboss Preview from reading its settings from the registry first so using it's
internal defaults.

Once running with the /S parameter any changes to the toolbar, dialog size etc
will be saved to the registry (N.B Not all things are saved, but additional things
could be added if required).

Once you have Lanboss Preview exactly as you require, exit the program and
take a copy of the above registry key, this can then be imported on the other
workstations you wish to use the program.
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3. Theory Of Operation

The primary task of Lanboss Preview is to make reports destined for a text printer
display correctly on screen and match the intended page breaks. 

In order to do this Lanboss Preview has to scale the font size down until the page
of the report fits on the page to be printed.

To calculate all this it does the following:

· Loads the entire text file into memory
· Scans the loaded file to see what the maximum number of characters

per line is
· Knowing the maximum number of characters per line tells it whether to

use a portrait or a landscape page layout. If the line length is less than
or equal to 85 it is considered a portrait report, above 85 and it is
considered a landscape report

· Scans the loaded file to see what the maximum number of lines there
are between page breaks

· Once the number of lines per page is known it decreases the font size
until that number of lines fits on the page

· Once the lines fit on the page, it then, if required reduces the font size
again so that the maximum line length will fit on the page

Once this has all been calculated it displays the results on the preview panel of
the main dialog.

When changes to the printer, font, margins etc are made it re-calculates the font
size and re-displays the results in the preview panel. (Note, it doesn't re-load the
file or re-calculate the line or character maximums, just adjusts the font size
based on the original calculations).
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4. Using Lanboss Preview

4.1 The Main Dialog

The main dialog shows the preview of the printout and allows the configuration of the
printer, page layout, fonts etc. 

Figure 1

4.2 Menus - The Main Menu

The main menu has four headings, File, Edit, View and Help the file menu
contains the following.
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File Menu

Figure 2

Open allows opening of other text files for viewing

Printer select the required printer from the drop down list

Page Setup displays the page setup dialog (see Page Setup section)

Print displays the print dialog (see the Print Dialogue section)

Save to PDF allows you to save the current document as an Adobe PDF
file

Exit this exits the Lanboss Preview

Edit Menu

The Edit Menu has a number of options mainly relating to how the output will
look:

Figure 3

The options are: 

Copy All To Clipboard which copies the entire contents of the file being viewed
to the clipboard. 

Font This is the name of the font to be used for the output 

Size This is the font size (in points) to be used for the output.
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Choose Auto to let the application try to best fit the font to
the size of the page or pick a font size to specify an exact
size to use

Auto Scale Click auto scale to set that as the Font Size in the option
above

History Use this to select a previous input document to display

View Menu

Use the View menu options to control how the output appears on screen, this
does not affect how it will print, but allows for detailed viewing.

Figure 4

The view menu contains the following:

Zoom In zoom in on the document

Zoom Out zoom out on the document

Zoom select the zoom level for the document

Help Menu

Figure 5

The help menu contains the following:

Preview Help opens the Preview Compiled HTML Help File

About Preview shows the Preview About screen
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Ask to View PDF's check this to be prompted to view PDF files after they have
been generated

Clear History clear all history items from the list

Delete delete the selected history item from the list

Max History Items maximum number of history items to maintain in the list

First Page go to the first page of the document

Previous Page go to the previous page of the document

Select Page allows the user to select a specific page

Next Page go to the next page of the document

Last Page go to the last page of the document

4.3 Toolbars

Toolbars within Lanboss Preview can be positioned along the top or the bottom of
the main dialog, currently there are:

The Print Toolbar

Figure 6.

From this toolbar you can select the printer you wish to print to, enter the Print
or Page setup dialogs or save the document as an Adobe PDF file.

The Navigation Toolbar

Figure 7.
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From this toolbar the user can navigate the document, either by clicking on the
navigation buttons or selecting a specific page from the drop down list.

The Edit Toolbar

Figure 8.

From this toolbar you can select the font you wish to print the document in and
the size of the font if you don't wish it to be automatically scaled.

The Zoom Toolbar

Figure 9.

The Zoom toolbar allows you to select one of the predefined zoom levels, enter
one of your choice or Zoom in/out at predefined step levels.

History Toolbar

Figure 10.

The History toolbar allows you to quickly recall previous documents. The
Trashcan button deletes the selected item from the list of documents, the
sweeping brush button removes all documents from the history list.

Help Toolbar

Figure 11.
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The help toolbar allows you to view the About screen, Help file and exit Lanboss
Preview.

4.4 Shortcut Keys

Within Lanboss Preview the following short cut keys are defined:

Alt+P enter the Page Setup Dialog

Alt+F4 exit the program

Ctrl+P enter the Print Dialog

Ctrl+C copy the current document to the clipboard

Ctrl+Home go to the first page of the document

Ctrl+End go to the last page of the document

PgDn go to the next page of the document

PgUp go to the previous page of the document

+ (Plus Key) Zoom in on the document

- (Minus Key) Zoom out on the document

F1 display the Lanboss Preview Help File
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4.5 The Print Dialog

Figure 12.

The print dialog allows you to print the document, select here:

Printer change the current printers properties and select whether
you wish to print to file or not

Print Range the range of pages you wish to print

Copies the number of copies you wish printed and whether or not
you wish them to be collated
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4.6 The Page Setup Dialog

Figure 13.

The page setup dialog allows you to change the following:

Page Margins here you may alter the page margins in inches

Page Boarders press the buttons here to turn on or off the line margin
printed on the corresponding edge of the paper

Page Numbers check this button to print page numbers in the lower right
hand corner of the page

Portrait / Landscape select here whether the page should be portrait or
landscape, altering this disables the auto scale feature
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5. Appendix

5.1 File Associations

In order for Explorer or Internet Explorer to automatically open up Lanboss
Preview when a file is clicked on, either the file type must be associated with
Lanboss Preview or the file must not have an extension at all. 

5.1.1 Example Registry File

The following file is an example of the registry changes needed to associate .out
files with Lanboss Preview, Preview being located in the C:\Program
Files\Lanboss\Preview directory.

REGEDIT4

[HKEY_CLASSES_ROOT\.out]

@="LanbossPreviewDataFile"

[HKEY_CLASSES_ROOT\LanbossPreviewDataFile]

@="Lanboss Preview Data File"

"EditFlags"=dword:00010000

"BrowserFlags"=dword:00000008

[HKEY_CLASSES_ROOT\LanbossPreviewDataFile\DefaultIcon]

@="C:\\Program Files\\Lanboss\\Preview\\lbPreview.exe,0"

[HKEY_CLASSES_ROOT\LanbossPreviewDataFile\Shell]

@="Open"

[HKEY_CLASSES_ROOT\LanbossPreviewDataFile\Shell\Open]

[HKEY_CLASSES_ROOT\LanbossPreviewDataFile\Shell\Open\Command]

@="\"C:\\Program Files\\Lanboss\\Preview\\lbPreview.exe\" \"%1\""
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5.1.2 Explorers View / Folder Options Dialogue

This is the more official route for setting up file associations, the file types tab on
this dialog allows users to configure which Application opens up file, along with
things like confirming whether or not the user always wants to open it without
prompting.

How Lanboss Preview Setup does it

The Lanboss preview setup program (or using the /R or /X command line
switches) directly edits the system registry to create the required file
associations; specifically it makes the following additions to the registry:

Firstly it creates the base file type key, this will differ depending on the chosen
file extension:

HKEY_LOCAL_MACHINE\SOFTWARE\SOFTWARE\Classes\{chosen extension}

It sets this keys default value to:

LanbossPreviewDataFile

Which tells applications where to look for this type of file.

It then creates the LanbossPreviewDataFile key, i.e.

HKEY_LOCAL_MACHINE\SOFTWARE\SOFTWARE\Classes\LanbossPreviewDataFile

and set's this keys default value to

LanbossPreviewDataFile

which shows up as the description of the file in Explorer. It then adds two other
values to this key:

BrowserFlags = 8

EditFlags=65536

This tells Internet Explorer to open the specified file type without asking.
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It then adds the location of the program to this key by adding the subkey:

Shell\Open\Command

and sets it's default value to the Preview executable e.g.

"""C:\Program Files\lbPreview.exe"" ""%1"""

The extra double quotes are there to stop problems with paths with spaces in
them, and the %1 tells explorer the Preview is expecting the filename to be
passed to it. It then sets up the default icon that should be shown in Explorer for
the chosen file type by adding a subkey:

DefaultIcon

and setting its default value to Previews path e.g.

C:\Program Files \Lanboss\lbPreview.exe,0

Once the setup program has made these additions to the registry, double clicking
on a file in Explorer or single clicking on a link in Internet Explorer, with the
specified file extension, will cause Lanboss Preview to open up and display it.
Files with the specified extension will also show up in Explorer with the Preview
Icon and the file type will show up as "Lanboss Preview Data File".

5.1.3 Click on a link in Internet Explorer

This does a similar thing as in Explorer, but instead of just opening, they get the
option to download the file. This Internet Explorer option can be disabled by
either running the setup program and selecting the disable open / save as option,
or by running preview with the /R command line.

5.1.4 Double click on a file in Explorer

This is the method most users discover by accident, Explorer being helpful allows
them to select which program they would like to use to open the file, and if they
would like the same thing to happen next time.
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5.2 Command Line Options

Lanboss Preview supports the following Command Line Options, in upper or
mixed case:

lbPreview <FileName> 

or

lbPreview /Option=Value<s>

<FileName> the filename that Lanboss Preview should display

/S Save application settings to registry

/D Load Default settings and ignore registry values

Revised in v6.0.4:

/R=<Extensions> This associates the lbPreview.exe program with one or more
file extensions specified in a list.  This option uses a list as
well as files with no extension, then disables the Browser
'Save As' dialogue for the specified associations.  The
following list treatments are possible: 

1. Added in v6.0.4: The list can have multiple values,
separated with semi colon characters as follows;
/R=.out;.prt;.prn;.outxx

(no space characters may be used in lists)

2. A single value;
/R=.out

3. Repeatedly calling with single or multiple values will add
to any existing associations

NB:a) /R specifically creates associations in
HKEY_CLASSES_ROOT

b) This option requires Local Administrative privileges to
work.

New in v6.0.4:

/A=<Extensions> Like /R above, this associates the lbPreview.exe program
with one or more file extensions specified in a list, but via
the HKEY_CURRENT_USER registry instead.  This may be
the only option available if no Local Administrative
privileges are available.  Use in exactly the same way as /R,
but with /A instead: 

1. The list can have multiple values, separated with semi
colon characters as follows;
/A=.out;.prt;.prn;.outxx
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(no space characters may be used in lists)

2. A single value;
/A=.out

3. Repeatedly calling with single or multiple values will add
to any existing associations

NB:a) /A specifically creates associations in
HKEY_CURRENT_USER

b) This option should be run on every logon to take care
of hotdesking users, such that the associations are re-
established for the current user per session.

/X Remove file extension associations, all associations in both
HKEY_CLASSES_ROOT and HKEY_CURRENT_USER are
attempted to be removed.  This option will also clear down
the lbPreview registry entry in the HKEY_LOCAL_MACHINE
registry hive.
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